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1 Einleitung

Mit der zunehmenden Verbreitung des Internets bis in unsere Wohn- und 
Arbeitsräume wächst bei vielen der Wunsch, dieses Medium um eine dritte 
Dimension zu erweitern. Forciert durch die moderne Medienelektronik 
und Kino!lme, die vor computergenerierten E"ekten nur so strotzen und 
nun auch im Wohnzimmer als Stereo-(3D-)Bilder ankommen, möchten 
viele Menschen auch einmal solche E"ekte produzieren oder zumindest 
verstehen, wie diese E"ekte funktionieren. Mit Blender ist ein Programm 
erhältlich, das genau diesen Einstieg bietet, ohne dabei den fortgeschritte-
nen und professionellen Anwender einzuschränken.

Als eines der wenigen Programme berechnet Blender sowohl Bilder und 
Animationen, die man aus Kino- und Fernsehproduktionen kennt, als auch 
interaktive 3D-Gra!k, wie sie in so gut wie allen modernen Spielen einge-
setzt wird.

1.1 Die Geschichte von Blender

Blender ist ursprünglich eine Entwicklung des niederländischen Animati-
onshauses »NeoGeo«. Als !rmeninterne Animationsso$ware wuchs Blen-
der dort mit den Au$rägen und wurde stetig weiterentwickelt. Nahezu zeit-
gleich mit der Verö"entlichung einer freien Version von Blender im Internet 
(Mai 1998) zog sich »NeoGeo« aus dem Geschä$ zurück. Dies war der Zeit-
punkt, an dem sich Ton Roosendaal sowie Frank van Beek, »Väter« und 
Hauptprogrammierer von Blender, entschieden, die Firma »Not a Number« 
zu gründen, um Blender weiterzuentwickeln.

Damit wurde Blender zu einem Produkt – allerdings zu einem in der 
Geschä$swelt sehr ungewöhnlichen, denn die frei erhältliche Variante von 
Blender war keine stark eingeschränkte Demoversion, sondern voll funkti-
onal, und die Lizenz ließ die uneingeschränkte Verwendung auch für kom-
merzielle Produktionen zu. Die Verbreitung von Blender auf CD war aber 
ausdrücklich von einer Genehmigung abhängig. Neben dem Vertrieb des 
Blender-Handbuchs wurde ein So$wareschlüssel von »Not a Number« ver-
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2 1 Einleitung

trieben, der den freien Blender zum »Complete Blender« mit vielen weite-
ren Funktionen freischaltete (der sogenannte C-Key).

Mit der Weiterentwicklung von Blender gingen immer wieder Eigenschaf-
ten des »Complete Blender« in den freien Blender über, bis in Version 1.80 
alle ehemaligen C-Key-Features freigeschaltet wurden.

Die Blender-Version 2.x wurde dann mit Funktionen erweitert, mit 
denen man komplette interaktive 3D-Welten oder -Spiele erstellen und 
auch in Blender abspielen konnte. Besonderer Schwerpunkt war hier die 
Erstellung von Spielen. Hiermit sollte ein Standard für 3D-Gra&k im Inter-
net gescha'en werden inklusive der entsprechenden geschä(lichen Mög-
lichkeiten. Leider waren die Ziele sehr hoch gesteckt, die Konkurrenz groß, 
und das Geschä(sziel konnte nicht erreicht werden. Nach einem Neustart 
(April 2001) als Nachfolge&rma »NaN« mit stark reduzierter Belegscha( 
musste auch diese Idee aufgegeben werden. Blender drohte in der Versen-
kung zu verschwinden, sämtliche Rechte an Programm und Quellcode gin-
gen an den Konkursverwalter.

Um Blender zu retten, wurde als Initiative von Ton Roosendaal die 
»Blender Foundation« gegründet, die durch Verhandlungen mit dem Kon-
kursverwalter erreichte, dass der komplette Quellcode für eine Einmal-
zahlung von 100.000 Euro »freigekau(« werden konnte. Am 18. Juli 2002 
wurde die Spendenaktion in der Blender-Community gestartet und bereits 
am 7. September 2002 konnte verkündet werden, dass genügend Geld 
bereitstand. Und so wurde Blenders Quellcode schließlich am 13. Oktober 
2002 unter der GNU General Public License [GNU] verö'entlicht.

Seit der Verö'entlichung von Blender unter der GPL wird jedes Jahr die 
Blender Conference in Amsterdam veranstaltet, jeweils ein Wochenende, 
an dem Künstler und Entwickler ihre Arbeiten präsentieren können und 
he(ig über die weitere Entwicklung von Blender diskutiert wird. 

Heute hat die Entwicklung von Blender ein Tempo angenommen, das in 
der So(warewelt seinesgleichen sucht. Einen großen Anteil an der aktuel-
len Entwicklung hatte sicherlich das von der Blender Foundation initiierte 
»Orange«-Projekt, das das erste »Open Movie« produzierte, also einen mit 
Open-Source-So(ware produzierten Film. Der Film selbst, wie auch alle 
seine Produktionsdateien, wurden parallel auf DVD und im Internet veröf-
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3Die Geschichte von Blender

fentlicht und können gemäß der Open-Content-Lizenz frei genutzt werden. 
Finanziert wurde das Projekt wie alle folgenden Blender-Filme aus DVD-
Vorverkäufen, Spenden und Sponsorings. »Elephants Dream« [ELE] stellte 
außerdem einige Rekorde auf, unter anderem als erste in Europa erschie-
nene HD-DVD. Alle während des Projekts entwickelten Features von Blen-
der gingen mit Version 2.42 in den Quellcode von Blender ein. 

Nach dem großen Erfolg von »Elephants Dream« (als Film, aber auch 
als »Entwicklungshilfe« für Blender) folgten weitere Projekte. Mit dem 
»Project Peach« wurde ein ganz anderer Stil geplant: »Niedlich und #au-
schig« war das Ziel von Ton Roosendaal, und so kam es, wie es kommen 
musste: »Big Buck Bunny«, so der Filmtitel, bekam als Hauptdarsteller vier 
Nagetiere. Wieder erhielt Blender mit diesem Open Movie einen enormen 
Entwicklungsschub, besonders bei der Partikeldarstellung und der Ren-
derpipeline. Durch den Film selbst erhielt Blender weltweite Anerkennung 
als 3D-So%ware.

Mit den Charakteren und Assets aus »Big Buck Bunny« entstand im 
folgenden »Apricot«-Projekt ein »Spiel zum Film«. Trotz andauernder 
Schwierigkeiten und dem Weggang der Entwickler, deren Game Engine an 
sich genutzt werden sollte, kam am Ende ein Spiel mit mehreren Leveln und 
einer guten gra&schen Anmutung heraus. Hier pro&tierte hauptsächlich die 
Blender-Game Engine von den Entwicklungen.

Im Mai 2009 wurde schließlich das Projekt »Durian« begonnen, das 
einige hochgesteckte Ziele verfolgte: Es sollte komplett mit der neuen (nicht 
einmal fertigen) Blender-Version 2.5x produziert werden – und das in 4K, 
also einer Au#ösung von ca. 4000 Bildpunkten in der Horizontalen, was 
etwa dem Doppelten normaler Kinoprojektoren entspricht. Dabei wurde 
von Anfang an Wert auf auf eine wirkliche Story gelegt und so konnte das 
Projekt mit Fördermitteln der Niederländischen Filmförderung so weit ver-
längert werden, dass fast alle Ziele erreicht wurden und die Premiere von 
»Sintel« – so der o*zielle Titel – pünktlich, wenn auch nur in 2K statt&nden 
konnte. Die 4K-Version wurde dann etwas später nachgeliefert.

Das Besondere an der Produktion von Sintel war, dass gleichzeitig eine 
lange vorbereitete, fast komplette Umstellung im Blender-Sourcecode statt-
fand, die zu einem leichter zu erweiternden Kern und einer einfacher zu 
bedienenden gra&schen Ober#äche führte. 

Mit Projekt »Mango« wurde dann Ende 2011 ein neuer Open Movie 
»Tears of Steel« [TOS] begonnen. Ziel war es diesmal, einen Mix von Real-
aufnahmen und Computergra&k zu machen. Dies erforderte unter ande-
rem einen Motion Tracker, mit dem Kamerabewegungen der realen Kame-
ras aus den Aufnahmen extrahiert und dann auf die Blender-Kameras 
übertragen werden, um eine perfekte Integration zu erzielen. Aber auch 
die komplette Pipeline an Tools wurde für die Arbeit an visuellen E,ekten 
und Color Grading verbessert. Gerendert wurde fast ausschließlich mit der 
neuen Renderengine »Cycles«.
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4 1 Einleitung

Wenn Sie dieses Buch in den Händen halten, hat die Entwicklung von 
Blender nicht gestoppt, seit Mango wurden die Tools konsequent weiterent-
wickelt, die Stabilität von Blender nochmals erhöht und die Bedienbarkeit 
weiter verbessert. Auch für die weitere Zukun! können wir gespannt sein, 
was sich in Blender tun wird.

1.2 Wen spricht das Buch an?

Dieses Buch soll kein Handbuchersatz für Blender sein. Das »richtige« 
Handbuch zu Blender ist die Blender-eigene komplette Referenz, die im 
Moment allerdings nur online zu erhalten ist [WIKI]. Das vor Ihnen lie-
gende Buch (oder das auf Ihrem Reader angezeigte eBook [EBOOK]) bietet 
stattdessen einen schnellen, praktisch orientierten und kompakten Einstieg 
in die Welt der 3D-Gra#k und -Animation, ohne dass man dafür teure oder 
in ihrer Funktionsvielfalt eingeschränkte Programme benötigt.

Blender ist durch seine Flexibilität für nahezu alle Arten der Compu-
tergra#k geeignet und spricht zahlreiche unterschiedliche Zielgruppen an: 

 ! Allgemein Computerinteressierte können mit Blender kostenlos in die 
Welt der 3D-Gra#k und -Animation einsteigen.

 ! Studenten lernen die Grundlagen der 3D-Gra#k mit einem Programm, 
das auch für den heimischen Rechner geeignet ist.

 ! Lehrer können jeden Schülerarbeitsplatz kostenlos mit dem Programm 
ausrüsten.

 ! Videoamateure erzeugen Animationen und Vorspanne für ihre Video#lme.
 ! Unabhängige Filmemacher, aber auch Studios benutzen Blender für die 

visuellen E$ekte in Filmen.
 ! Webdesigner entwickeln 3D-Objekte für Internetseiten und WebGL 

sowie Logos und Schri!züge.
 ! Computerspieler erscha$en neue Welten und Objekte für Spiele oder 

versuchen sich sogar an einem eigenen Spiel.
 ! Mutimediadesigner erzeugen Gra#ken und Animationen für CD- und 

DVD-Projekte.
 ! Wissenscha!ler visualisieren ihre Forschungsergebnisse und erstellen 

Lehr#lme. 
 ! Ingenieure und Techniker zeigen mit Animationen die Funktion von 

technischen Geräten und Vorgängen.
 ! Architekten visualisieren ihre Entwürfe und machen sie virtuell begehbar.
 ! Programmierer möchten die Entwicklung von 3D-Programmen anhand 

des Blender-Quellcodes verstehen lernen und an der Entwicklung von 
Blender in einem multinationalen Team arbeiten.

 ! Anhänger und Verfechter des Open-Source-Gedankens helfen durch 
Fehlerberichte, Blender besser und noch stabiler zu machen.

Zukunft
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1.3 Fähigkeiten von Blender

Während seiner bewegten Entwicklung wurde Blender schon von allen 
oben genannten Personengruppen erfolgreich benutzt, da Blender für 
jeden Anwendungszweck Funktionen zu bieten hat, die man bei anderen 
Programmen entweder teuer kaufen muss oder die gar nicht vorhanden 
sind. In den webbasierten Diskussionsforen [BA], [BP] von Blender !nden 
sich zahlreiche Erfahrungsberichte, die teilweise auch zu neuen Funktio-
nen in Blender führten.

Die wichtigsten Fähigkeiten von Blender sind in der folgenden Liste 
zusammengetragen. Hier werden viele Begri"e benutzt, die für einen Ein-
steiger eventuell noch völlig unbekannt sind. Wer sich allerdings schon ein-
mal mit dem Funktionsumfang von 3D-Programmen beschä$igt hat, wird 
viele Begri"e wiedererkennen. Allen Einsteigern sei versichert, dass sie 
nach Lektüre des Buches viele der Begri"e kennen und diese Möglichkeiten 
kreativ anzuwenden wissen. Nicht zuletzt soll diese Liste neugierig machen.

Allgemein

 ! Modellierung mit Polygonnetzen (Meshes, BMesh), Subdivision-Surface-
Meshes, Kurven (Bézier, NURBS), NURBS-Flächen, 3D-Texten, Metaballs

 ! Sculping von Meshes (Mesh Bildhauerei) 
 ! Animation mit Keyframes, Pfaden (Pfadobjekt, Kurven), Morphing, 

Vertex Keys, IK-Systemen, Skelettsystemen, Lattices, skriptgesteuerten 
und physikbasierten Animationen

 ! Partikelsysteme zur Erzeugung von Feuer, Rauch, Explosionen, Fell, 
P%anzen oder Fischschwärmen

 ! Fluid-, Rauch-, Feuer- und Kleidungssimulation
 ! Komplette Echtzeitgra!k-Umgebung (»Game Engine«)
 ! Skriptsprache (Python) zur Erweiterung der Funktionalität, zum Model-

lieren und zur Animation, inklusive integriertem Texteditor
 ! Schnittsystem für die Nachbearbeitung von Animationen 
 ! Composer für die Au&ereitung von Animationen und Real!lm, Keying 

und Color Correction 
 ! Feature und Object Tracking, Masking für die Integration von Compu-

tergra!k in Real!lm
 ! Kompaktes Dateiformat (*.blend), volle Kompatibilität zwischen den 

verschiedenen Rechnern und auch den Blender-Versionen
 ! Umfangreiche Import- und Exportmöglichkeiten zu anderen 3D-Formaten 
 ! Schneller Renderer inklusive Raytracing, Ambient Occlusion und Indi-

rect Light (Blender Intern)
 ! Cycles Renderer für fotorealistische, physikbasierte Berechnungen
 ! Vielfältige Bild- und Animationsformate: Targa, JPEG, PNG, AVI, 

H.264, MPEG-4, HDR-Formate 
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6 1 Einleitung

Die Ober!äche
 ! Freie Au!eilung der Fenster/Arbeits"äche
 ! 3D-Fenster: Wireframe, Solid, OpenGL, OpenGL texturiert, gerendert
 ! Skalierbare Button Windows (Fenster mit Schalt"ächen), anpassbar an 

die Bildschirmau"ösung
 ! Layer, mehrere Arbeits"ächen, mehrere Szenen pro Datei 
 ! GUI in Python programmiert und leicht anpassbar

Berechnung

 ! vier leistungsfähige Renderengines für jeden Zweck, weitere per Add-
on nutzbar

 ! Oversampling gegen Aliasing (harte Kanten)
 ! Au"ösungen bis 10.000 x 10.000 Pixel
 ! Special E&ects wie Partikel, Feuer, Rauch, Flüssigkeiten, Objektkollisionen
 ! Schnelle Schattenberechnung durch Shadow Bu&er, weiche Schatten 

oder Raytracing-Schatten
 ! Selektive Beleuchtung über das Layer-System
 ! Motion Blur (Bewegungsunschärfe) für Animationen 
 ! Farbmanagement für einen linearen Arbeitsablauf
 ! Panorama Rendering zur Erstellung von navigierbaren Panoramen für 

Spiele und Multimedia-CDs

Diese gesamte Funktionalität steckt in etwa 40 bis 80 Megabyte Archiv, das 
entpackte Programm benötigt etwa 200 MB auf der Festplatte. Solange eine 
3D-Gra*kkarte vorhanden ist, lässt sich Blender auch auf langsameren 
Rechnern gut einsetzen.

Szenen werden dank eines ausgeklügelten Speicherformats (ähnlich der 
Erbsubstanz DNA) sehr schnell gespeichert und geladen. Im Gegensatz zu 
den meisten anderen Programmen sind die Dateien von Blender groß teils 
auf- und abwärtskompatibel, d.h., eine ältere Blender-Version kann noch 
Dateien ö&nen, die mit dem neuesten Blender erzeugt wurden. Eine Aus-
nahme sind z.B. die Animationsdaten, die mit Blender >2.5x erzeugt wurden 
und in Blender-Versionen <2.5x geö&net werden. Einen weiteren Bruch gab 
es leider durch die Einführung des neuen Mesh-Systems »BMesh«. Diese 
Kompatibilität ist insbesondere für die zukün!ige und stetig fortschrei-
tende Entwicklung von Blender wichtig. Es wird nie einen Blender geben, 
der die alten(!) Dateien nicht mehr lesen kann, wie es bei vielen anderen 
Programmen üblich ist. Zudem wird jemand, der mit einer älteren Version 
arbeitet, immer auch die Dateien, die mit der neuen Version erzeugt wur-
den, lesen können (mit Einschränkungen, s.o.) und nicht gezwungen, eine 
neue Version zu installieren.

Alle Informationen, die eine Szene betre&en, können (müssen aber 
nicht) in einer einzelnen Datei gespeichert werden, z.B. auch die gesamten 
persönlichen Einstellungen des Animators. Trotzdem bleibt über ein ausge-

Geringe Größe des 
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klügeltes System jedes Objekt der Szene für andere Szenen erreichbar und 
kann in diese hinzugeladen oder nur verbunden werden, was eine Teamar-
beit von mehreren Animatoren sehr erleichtert.

Eine herausragende Eigenscha! von Blender ist die Verfügbarkeit auf 
nahezu allen modernen Hardwareplattformen unter allen Betriebssyste-
men. Blender ist damit eines der wenigen wirklichen Multiplattformpro-
gramme. Hierdurch können Firmen und Institutionen (Universitäten!) 
auch bei stark heterogener Rechnerhardware ein Programm erhalten, um 
z. B. mit dem Au"au von Renderfarmen ihre Hardware optimal zu nutzen.

Meiner Meinung nach ist Blender ein absolut professionell zu verwen-
dendes Animationsprogramm mit einem (als Open Source naturgemäß) 
unschlagbar günstigen Preis. Das konnte schon bei etlichen Projekten unter 
Beweis gestellt werden.

1.4 Ziel dieses Buches

Dieses Buch möchte und kann auch nicht die englische Online-Referenz 
[WIKI] von Blender ersetzen. Das Dokumentationsmaterial, DVDs und 
andere Artikel um Blender werden direkt von der Blender Foundation 
vertrieben und die Verkaufserlöse sind ein wesentlicher Faktor, um auch 
weiterhin den weltweit operierenden Entwicklern eine gute Basis (Gehäl-
ter, Server, Foren, Mailinglisten) zur Verfügung zu stellen und auf wich-
tigen Messen und in den Medien präsent zu sein. Hiermit möchte ich Sie 
auch ermutigen, bei neuen Open-Movie-Projekten eine DVD zu kaufen, 
um Blenders Entwicklung direkt anzuschieben oder aber direkt zu spen-
den [BFFUND].

Das Ziel dieses Buchs ist es, den Benutzer von Blender anhand von Bei-
spielen zum Experimentieren und Benutzen von Blender zu animieren und 
dabei nicht nur die Ober#äche anzukratzen, sondern ihm auch zu einem 
tieferen Einblick in die 3D-Gra%k zu verhelfen. Es ist durch die riesige 
Funktionsvielfalt von Blender allerdings ein unmögliches Unterfangen, alle 
Möglichkeiten von Blender anhand von praktischen Beispielen zu erklä-
ren. Im Handbuch dagegen sind alle Knöpfe und Parameter kurz erklärt 
ohne viele Beispiele zu deren Benutzung, es bietet sich daher als Referenz 
zu Blender an. Im Moment ist das Handbuch nur im Internet einzusehen.

1.5 Sprachliche Konventionen

In der Computergra%k kommen und kamen viele wichtige Impulse und 
Entwicklungen aus Ländern, in denen Englisch gesprochen wird. Insbeson-
dere die USA mit ihren großen Filmfabriken bringt immer wieder erstaun-
liche E&ekte hervor. Zusammen mit der Leitmesse für Computergra%k, der 

Blender im Vergleich

http://www.blender.

org/education-help/

Lernen mit Beispielen 

Blender spricht Englisch.
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SIGGRAPH Messe [SIGGRAPH] in den USA, hat sich so Englisch als Stan-
dardsprache der Computergra!k etabliert.

So taten auch die ursprünglichen Entwickler von Blender gut daran, 
Blender nicht auf Niederländisch zu lokalisieren, obwohl dies für die Ver-
wendung als Inhouse-So"ware sicher gerechtfertigt gewesen wäre. 

Inzwischen ist Blender durch die Arbeit der weltweiten Entwicklerge-
meinde fast in jede Sprache mehr oder weniger gut übersetzt. Ich persön-
lich halte aber nichts von der gewaltsamen Übersetzung aller Fachaus-
drücke, und was nach einer Übersetzung der Ober#ächenelemente übrig 
bleibt, ist o" ein schlimmes »Denglisch«. Hinzu kommt, dass wenn man 
einmal die wichtigsten Fachbegri$e erlernt hat, auch ohne große Englisch-
kenntnisse den Diskussionen in der internationalen Community folgen 
kann. Ich ho$e, die Verwendung der englisch-internationalen Version in 
diesem Buch trägt dazu bei, dass die gesamte Blender-Gemeinde eine Spra-
che spricht, und verhindert so eine Nationalisierung, wie sie die Benutzer 
manch kommerzieller So"ware spaltet.

In reinen Text-Tutorien werden Tasten o" als AKEY, BKEY etc. ausge-
zeichnet. In diesem Buch verwende ich stattdessen einen speziellen Font 
(Linux Biolinum Keyboard, [LIBERTINE]), um die Tasten gra!sch darzu-
stellen. Diese Darstellung hebt sich gut im Fließtext ab, und mit Kenntnis 
der Tastaturkürzel kann man schnell die wichtigen Stellen im Text ausma-
chen und nachvollziehen. Einzelne Tasten erscheinen als A, dann B und 
C bzw. zusammengerückt als SX0!, wenn sie direkt hintereinander 
gedrückt werden sollen. Tastenkombinationen, bei denen eine Taste gehal-
ten werden muss, während die zweite gedrückt wird, werden als "-A 
notiert. Die Cursortasten als ←→↑↓, die Leertaste als '. Der 
wichtige Zi$ernblock wird mit  bis  und ,  etc. dargestellt. 

Normale Tasten müssen nicht gedrückt gehalten werden, sondern es 
reicht ein kurzer Druck, um die Funktion zu starten und auszuführen. 
So ru" z.B. G das Verschieben eines Objekts auf und man kann dann – 
während das Objekt mit der Maus bewegt wird – schon die nächste Taste 
anvisieren oder eine zweite Taste drücken, die die aktuelle Aktion noch 
verändert.

Für die Texte aus der Ober#äche und den Menüs habe ich eine Schri"-
art gewählt, die der Bildschirmdarstellung ähnlich ist, wie z.B. die Beschrif-
tung eines Knopfes als End: 250 oder ein Menüeintrag als View→Save As... 

Obwohl sich Blender zweihändig mit Maus und Tastatur am besten und 
schnellsten bedienen lässt, sind natürlich aufgrund des begrenzten Tasten-
vorrats nicht alle Funktionen per Tastatur zugänglich. So macht Blender 
dann auch ausgiebig Gebrauch von Icons, also kleinen bildha"en Beschrei-
bungen und beschri"eten Knöpfen. Um den Lese#uss nicht zu sehr zu 
hemmen, wird im Text soweit möglich der Name der Funktion genannt 
(der sich dann auch im Such-Menü (') !nden lässt) und in der Rand-
spalte das entsprechende Icon abgebildet.

Auszeichnung der Tastendrücke

Auszeichnung der Programmtexte

Parent-Icon als Beispiel
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Die Maustasten habe ich entweder direkt im Text!uss als linke, mitt-
lere oder rechte Maustaste beschrieben oder mit ihren Icons ,  und  
ausgezeichnet.

1.6 Buchbegleitende Dateien 

Begleitend zu den Übungen und Anleitungen habe ich auf meiner Home-
page http://blenderbuch.de/daten/Dateien.php die Dateien zu den 
einzelnen Schritten der Übung abgelegt und fortlaufend nummeriert. Diese 
Dateien verwenden Sie als Startpunkt für Ihre eigenen Experimente oder 
als Begleitung zu den Übungen, falls Ihre Zeit nicht ausreicht, sie komplett 
durchzuarbeiten, oder falls Ihnen ein Schritt in der Anleitung nicht klar 
ist. Auch wenn ich nicht explizit auf eine Datei verweise, "nden Sie sicher-
lich noch einige weitere interessante Dateien. Einen Hinweis auf eine lad-
bare Datei gibt das Datei-Icon in der Randspalte. Hier "nden Sie auch einen 
Link zu einer großen Zip-Datei die alle Dateien und die Extras gesammelt 
enthält.

Als weiteres Extra gibt es auch Videos der einzelnen Übungen auf mei-
nem YouTube Kanal »DasBlenderBuch« [YT]. Diese Videos können Sie als 
schnellen Überblick oder als Hilfe wenn beim Lesen etwas unklar bleibt 
benutzen.

1.7 Kontakt und Support

Gerne beantworte ich Ihnen Fragen zum Buch oder zu Problemen mit 
Übungen aus dem Buch, auch Kritik und Lob dürfen Sie mir gerne per 
E-Mail an cw@blenderbuch.de senden. Fehlerbereinigungen (Erratas) 
oder Anpassungen an neue Blender-Versionen poste ich auf meiner 
Google+-Blender Buch-Seite [GPLUS]. Hier werde ich auch buchbeglei-
tende Videos sammeln. 

Suchen Sie professionelle Hilfe bei Ihren Projekten oder einen Blender-
Lehrer, dann schauen Sie sich doch einmal mein Pro"l beim Blender Net-
work [NETWORK] (englisch) oder auf meiner Homepage [TRAINING] 
(deutsch) an.

1.8 Überlebenstipps für Umsteiger  von Blender 2.4x

In diesem Abschnitt werde ich noch einige Tipps geben, die es Nutzern älte-
rer Blender-Versionen (<2.5x) leichter machen, auf aktuelle Blender-Versi-
onen umzusteigen. Darüber hinaus gebe ich auch Umsteigern von anderen 
3D-Paketen ein paar Hilfen mit auf den Weg.

Die Maustasten

Videos zum Buch

Von älteren Blender-

Versionen und anderen 

D-Paketen zu 

Blender 
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1.8.1 Umsteiger von anderen 3D-Programmen

Die folgenden Hinweise gelten für Umsteiger von anderen 3D-Modellie-
rungsprogrammen.

 ! Verabschieden Sie sich von den System-File-Dialogen, lernen Sie die 
File Windows von Blender nutzen und schätzen.

 ! Blender benutzt ein Koordinatensystem, bei dem die x-y-Ebene (Papier-
ebene) auf dem Tisch liegt und die z-Achse nach oben in den Raum 
zeigt.

 ! Gespiegelt wird in Blender entlang einer Achse und nicht – wie bei uns 
im Matheunterricht gelernt – an einer Achse.

 ! Es gibt jetzt ein Quad View (View → Toggle Quad View !-"-Q).
 ! Für Umsteiger gibt es Presets (auch aus dem Splash Screen heraus 

wählbar), die grundlegende Bedienungen von anderen Programmen 
nachstellen.

 ! Tastenbefehle können angepasst werden. Hierbei (wie auch beim vor-
herigen Punkt) ist aber zu beachten, dass man sich damit etwas von der 
Community entfernt und es nicht mehr so einfach ist, Tutorials und 
Übungen zu folgen.

1.8.2 Umsteiger von Blender-Versionen vor 2.5

Blender stieß mit den Versionen der 2.4x-Reihe irgendwann an die Grenzen 
seiner Erweiterbarkeit: Sowohl das Layout als auch der technische Unterbau 
waren nicht mehr sinnvoll zu erweitern, obwohl immer mehr fortschrittli-
che Funktionen genau dies erfordert hätten. Daher wurde dieser Unterbau 
für die Blender-Version 2.5x komplett neu programmiert in 2.6 weiterge-
führt. Augenscheinlich resultiert dies in einer neuen Ober'äche, intern in 
einem komplett neuen Event-System (Ereignisse wie Tastendrücke, Maus-
bewegungen etc.) und einer neuen Datenstruktur namens RNA (in Anleh-
nung an die DNA-Methode, mit der Blender seine Dateien speichert und 
verwaltet), die einen direkten Zugri( auf alle Interna Blenders für Anwen-
der und neue Funktionen bietet. Die Ober'äche wird nun durch Python-
Skripte gezeichnet, was eine schnelle und einfache Anpassung möglich 
macht und auch dynamische Prozesse in der Ober'äche erlaubt. Durch das 
neue Event-System werden in naher Zukun) z.B. auch Makro-Aufzeich-
nung und eine komplette History der ausgeführten Befehle möglich.

Grenzen der 

Entwicklung
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Die Ober!äche hat sich gegenüber Blender 2.49 deutlich geändert. Die 3D 
Views sind praktisch als einzige noch nahezu unverändert. Andere Berei-
che wie der Node Editor oder der UV Image Editor wurden im Rahmen 
von Verbesserungen leicht geändert, sind aber noch wiederzuerkennen.

Die Ober!äche ist jetzt viel stärker vertikal orientiert und so auch für die 
aktuellen Breitbildmonitore optimiert. Die alten Buttons Windows waren 
zwar etwas übersichtlicher, aber eine Erweiterung war dort kaum noch 
möglich, ohne schließlich doch scrollen zu müssen. Die einzelnen Panels 
im Properties Editor lassen sich natürlich auch jetzt noch minimieren. 
Neu ist allerdings, dass man die Hauptfunktion jetzt auch bei minimiertem 
Panel aus- oder anschalten kann.

Das Tool Shelf bietet je nach Objekt und Aufgabe die passenden Tools an, 
ohne dass man in verschiedenen Buttons Windows suchen muss. Weiter-
hin ist es hier möglich, Parameter für die gerade aufgerufene Funktion zu 
ändern.

Dadurch dass es jetzt keine schwebenden Fenster (Floating Panels) mehr 
gibt, mussten Bereiche wie die Transform Properties oder Background 
Images in die nun allgemeinen Properties weichen (weiterhin über das Tas-
tenkürzel N erreichbar).

Die Toolbox ist Geschichte (s.u.): Auf der prominenten Leertaste liegt 
jetzt das Such-Menü. Wenn Sie einen Befehl suchen, lohnt es sehr, hier ein 

Abb. . 

Die neue Oberfläche

Vertikale GUI

Tool Shelf

Such-Menü
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paar Buchstaben des Befehlsnamens einzugeben, um die passende Funk-
tion zu !nden und so auch die Tastenkombination angezeigt zu bekommen.

Fensterln für Fortgeschrittene: Window Manager

Fenster lassen sich in der Größe ändern, indem man mit der Maus über die 
Fensterkante fährt, bis der Mauscursor zu einem Doppelpfeil wird, und 
dann per Click & Drag mit der linken Maus die Fenstergrenze verändert.

Fenster oder Areas der Editoren (z.B. 
3D View) werden aufgeteilt, indem man 
per linker Maus eine der Ecken im Fenster 
anklickt, hält und in das Fenster zieht, das 
aufgeteilt werden soll.

Bereiche zusammenfügen geschieht, in-
dem per Click & Drag eine der Ecken aus 
dem zu erhaltenden Fenster in das zu schlie-
ßende Fenster gezogen wird. Alternativ 

können Fenster auch durch das Area-
Options-Menü geteilt und zusammen-
gefügt werden. Dieses Menü erscheint, 
wenn man  über einer Fensterkante 
(Mauscursor ist ein Doppelpfeil) 
drückt. 

Der Header eines Fensters kann 
durch einen Rechtsklick darauf und 
Auswahl von Flip to Bottom bzw. Flip to 

Top zwischen oben und unten im Fenster umgeschaltet werden.
Durch "-Click & Drag von einer Fensterecke in ein anderes Fenster 

können die Fenstertypen getauscht werden.
Blenders Ober#äche kann nun auch in separate Fenster aufgeteilt wer-

den, wobei in jedem neuen Fenster die Ober#äche frei gestaltet werden 
kann – ideal für Multimonitor-Setups. Um ein Fenster von der Ober#äche 
abtrennen und frei bewegen zu können, halten Sie die #-Taste, klicken 
auf die Fensterecke und ziehen diese in das abzutrennende Fenster hinein. 
Dies ist vielleicht nicht die intuitivste Methode, aber sehr e$ektiv und ohne 
große Mausbewegungen möglich. Wenn Sie das neue Fenster nicht mehr 
benötigen, schließen Sie es einfach.

Weiterhin gibt es in Blender jetzt eine echte Vierseitenansicht ("-$- 
Q oder im View-Menü), die im Gegensatz zum oben beschriebenen Auf-
teilen eines Fensters die Eigenscha%en von z.B. 3D Cursor und Shading-Typ 
miteinander teilt und somit wie in anderen Programmen arbeitet.

Teilen

Zusammenfügen

Header

Fenstertausch

Neue Fenster
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Wo zum Teufel ist dieser Button hin?
Besonders Umsteiger oder Einsteiger, die noch mit Tutorials von Version 
2.4x arbeiten, werden o# ausrufen: »Wo zum Teufel ist dieser Button hin?« 
Hier ein paar Tipps, wie man sich schneller zurecht$ndet.

 ! Wo ist die Toolbox (!)?  
Die Toolbox existiert nicht mehr. Objekte erzeugt man jetzt (wie auch 
schon früher) mit "-A. Die anderen Funktionen der Toolbox sind 
entweder im Tool Shelf (T), in den entsprechenden Tabs oder über 
die Suchfunktion (!) zu $nden. Alternativ gibt es ein Add-on 
»Dynamic Spacebar Menu«, das die Funktionen der alten Toolbox 
simuliert.

 ! User Preferences  
Die User Preferences verstecken sich nun nicht mehr hinter dem Info 
Window bzw. dessen Header-Leiste, sondern haben einen eigenen Edi-
tor bekommen, den Sie auch über File → User Preferences (#-$-
U) aufrufen können. Gespeichert werden die Voreinstellungen wie 
gehabt per #-U oder über den Button Save As Default aus dem Pre-
ference-Fenster heraus.

 ! Set Smooth/Solid?  
Da es keine Editing Buttons mehr gibt, sind diese und ähnliche Funk-
tionen jetzt im Tool Shelf (T) oder per Suchfunktion zu $nden (Shade 
Smooth/Flat).

 ! Spin/Screw/Flip Normals/Remove Doubles  
Wie früher auch $nden sich diese Funktionen bei aktiviertem Edit Mode 
im Specials-Menü (W) oder auch in der Tool Shelf (T).

 ! Background Images
Background Images werden jetzt im Properties Shelf (N) vergeben und 
nicht mehr im View-Menü. Alternativ können nun auch Empties Bil-
der zeigen.

 ! Logic Buttons  
Die Logic Buttons sind nicht (wie z.B. die Material Buttons) in die Pro-
perties Tabs gewandert, sondern haben jetzt einen eigenen Window 
Type, den Logic Editor, aufzurufen über den Editor Type unten links in 
jedem Fenster oder "-%.

 ! Game-Engine-Physik  
Die Einstellungen zur Game-Engine-/Echtzeit-Physik sind in das 
Physics-Panel gewandert, dort allerdings nur zu sehen, wenn als Ren-
der Engine Blender Game angewählt ist.Das Weiterschalten um zehn Bil-
der in einer Animation ist jetzt "-↑, ↑  alleine schaltet jetzt zum 
nächsten Keyframe des aktiven Objekts.
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 ! Ipo-Kurven  
Ipo-Kurven nennen sich jetzt F-Curves und werden im Graph Editor 
bearbeitet. Da das gesamte Animationssystem praktisch neu program-
miert wurde, ist der Graph Editor für Umsteiger etwas gewöhnungsbe-
dür!ig. Animationen werden jetzt viel stärker im Dope Sheet und als 
Actions bearbeitet und dann im NLA-Editor verwendet.

 ! Circle Select  
Circle Select wird jetzt durch C und nicht mehr BB aufgerufen.


